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Flash Fill 
The Flash Fill feature in Excel 2013 saves you time when you are trying to reshape imperfect data. Many times, 
you get data from somewhere that isn’t in the right format—the text is all caps, phone numbers appear 
without dashes, or a bunch of fields are jammed into a single column. By providing one or two examples of 
what you are trying to do, Flash Fill uses heuristics to make a correction of the data in an adjoining column. 
 

Cleaning Data with Flash Fil 
Let’s assume that you have a file with first names in column A and last names in column B. The names are in 
uppercase. You would like to reshape the data, so you have the full names in proper case. 
 
If you have been using Excel for many years, you might instinctively think of the formula: 
 
=PROPER(A2&" "&B2). Enter that formula in C2, copy down, copy, and paste values to solve the problem. 
Unfortunately, far too many people think that formula is too intimidating, and start simply typing the new data, 
as shown in the figure below. 
 

 
 

In Excel 2013, and later, as soon as you type the first letter in the second cell, Excel springs into 
action and offers to fill the rest of the column for you as shown in the figure below. If you are 
satisfied that the preview is correct or even close, simply press Enter. 
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In addition to filling the column, Excel provides two pieces of feedback. First, the status bar in the 
lower-left corner of the screen indicates that Flash Fill changed 21 cells. 

 

 
You can also choose to select all changed cells or all unchanged cells. You find out more about 
unchanged cells in the next section. 

 

 
Excel easily recognizes all sorts of patterns. You could fill from “Mike”, “Mike H.”, or “HENDERSON, 
MIKE”. Sometimes, Excel needs a bit more information. If you start with Mr. Mike Henderson in C2, 
nothing happens when you start to type M in C3. You have to type Mr. James Moore in C3. As soon as 
you type M in C4, Excel fills the column. However, Excel blindly uses Mr. for Marilyn, Lori, and 
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Christine so sometimes you will have to do a little extra work to correct the data. 
 

Coaching Flash Fill with a Second Example 
 

That first Flash Fill example works like a charm. However in the world of imperfect data, things are not always so 
clear. In this example we will use the data in the Names3 tab. 
 
Type Mike H. in C2, and then type J in C3. Excel sees that you are doing first name, last initial, and a period. The 
preview shows many names being filled in, as shown in Figure 12 - Cells Left Blank. However, the status bar 
indicates “Flash Fill Blank Cells: 3 Flash Fill Changed Cells: 18.” When there is missing data, such as no last 
name for Cher, Excel leaves the cells blank as shown in the completed example below. 
 

 
 
 

 



Copyright © 2018, K2 Enterprises, LLC. Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited. 

 

At this point you need to provide Excel with a second example. Go to cell C5, type Cher, and press Enter. Excel 
now understands the rule for people without a last name. Excel fills in Sting in C10 and Pele in C15, as shown 
inFigure 14 - Providing a Second Example. The status bar indicates “Flash Fill Changed Cells: 2.” Those two cells 
are automatically selected. 
 

 
 
 

Inserting New Characters in a Telephone Number 
 
Flash Fill works great when you are formatting a telephone number. Open the Phone tab for this example. In 
Figure 15 - Formatting a Phone Number the 10-digit phone numbers appear without parentheses or dashes in 
column B. 
 
We want to format the telephone numbers with a parenthesis around the area code and a dash in the 
telephone number. 
 
Insert a new column C. Type a heading in C1. Retype the first phone number in C2 as (907) 555- 2750. As soon as 
you type the opening parenthesis in C3, Flash Fill offers to fill in the rest of the column (see Figure 15 - 
Formatting a Phone Number). 

Note that the new values are static values. They are not formulas. After Flash Fill works, you are free to 
delete the original column without having to worry about the new column changing to #REF errors. 
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Using Commas Helps Flash Fill 
 

In this example I am using the data in the ADDR1 tab. A comma is being used in column C to separate the city 
and state. When there is a comma, the Flash Fill in column D works perfectly to get the city every time as shown 
in the figure below. 
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But in real life, bad data isn’t pretty. If the city and state are in a column without a comma between you have a 
problem. That is the case with the data in the ADDR2 tab. With this situation Flash Fill doesn’t work perfectly this 
first time around’ It only picks up the first part of a city that has two words like Las Vegas. 
 

 
To solve this problem type Fairbanks in D2 and then type B from Birmingham in D3. Flash fill goes to work and fills in 
all of the cells for you. This problem is a bit more insidious because there aren’t any blank cells to make you 
realize that it did not work. Luckily, the problems are showing up in the first part of the data, so you might 
notice the Las in D4. However, I  can certainly foresee a situation where you have 9,000 records that say 
Henderson a nd  only five records that say Las Vegas, and those latter records don’t start until row 8642. In such 
a case, it would be really tough to realize that there is a problem. 
 
Assuming you notice the problem, Excel can recover for you. Go to the first cell that is wrong in the Flash Fill 
results and type the correct value. Type Las Vegas in F4. Excel then fills in St. Louis, Fort Worth, and Cocoa Beach  
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Fuzzy Lookup 
Fuzzy Lookup is a recent addition to Excel that allows you to match data that is close but not exact. If you have 
two lists of employee names, as an example, and you are trying to see if any of the employees on the first list 
also appears on the second, Excel is a great tool to utilize by using functions such as MATCH or VLOOKUP. 
What if the same employee appears on one list as “Steven Jenkins,” and on the other as “Steve Jenkins”? The 
effort to match would fail. It would, however, work if you were using Fuzzy Lookup. 
 
Obtaining and Installing Fuzzy Lookup 
 
Fuzzy Lookup is a free add-in available from Microsoft at the following URL: http://www.microsoft.com/en-
us/download/details.aspx?id=15011 .  The setup file for Fuzzy Lookup is to be found in the Teaching File folder. 
The installation file is only 1.5 megabytes in size and generally takes only a few seconds to download. However, 
since this is just an installation file, more content is added to your computer during the installation process. 
Once the download completes, double-click the file, which is appropriately named FuzzyLookupForExcel.zip to 
show it in uncompressed form. Next, double-click Setup.exe to start the install process. Read the End User 
Licensing Agreement (EULA) and select Accept. Follow the on screen prompts to complete the installation. 
 
Once it finishes, start Excel; you should now see a new tab on the ribbon labeled Fuzzy Lookup. If you do not, click 
on the File tab and choose Options. Next, select Add-ins from the left pane of the Excel Options dialog box. Then, 
from the Manage: drop-down list, choose COM Add- ins and then press Go. You will see the COM Add-Ins 
dialog box shown in the figure below. Make sure that a checkmark appears in the box next to Fuzzy Lookup Add-
In for Excel and then click OK. 

http://www.microsoft.com/en-us/download/details.aspx?id=15011
http://www.microsoft.com/en-us/download/details.aspx?id=15011
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Using Fuzzy Lookup 
 

The Fuzzy Lookup Add-in matches inexact textual data and allows you to join data from multiple tables into one 
based on these matches. This being the case, the first step in the process is to make sure that the data you are 
comparing is resident in tables. If it is not, convert the ranges to tables by placing the cursor in the data range and 
holding down the Control Key (Ctrl) on your keyboard and then pressing the letter “T.” 
 
The table below presents two tables we will use for the basis of our Fuzzy Lookup. SSN is the name of the table on 
the left, and Comp is the name of the table on the right. We would like to match the Name field in SSN to the 
Name field in Comp and create a results list that shows employees’ names, Social Security numbers, and 
compensation. 
 
The challenge we face is that not all of the names are spelled and arranged the same way; therefore, if we 
attempt to use a VLOOKUP function to complete this task, we will not be successful. For example, consider the 
name Jan Kotas on row 4 of SSN. In looking at row 8 of Comp, we see that what should be the matching name is 
arranged as Kotas, Jan; thus, a VLOOKUP function would not match the two names together. Likewise, Robert 
Zare on row 8 and Thomas Axen on row 13 of SSN are not exact matches to Robert Zare, III on row 11 and T G 
Axen on row 17 of Comp, again presenting problems if we try to match based on traditional methods. 
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However, we can match the data in these two tables using the Fuzzy Lookup Add-in. Position your cursor in the 
cell where you want the results to appear. Then click Fuzzy Lookup on the Fuzzy Lookup tab of the Ribbon to 
open the Fuzzy Lookup task pane on the right side of the window shown in the table above. Upon doing so, 
Excel automatically senses and inserts the names of the tables into the Fuzzy Lookup task pane. Excel also 
automatically analyzes the columns in the tables and joins the tables if a column in one table has the same 
column header as a column in the other table. Of course, you can edit both the table and column selections, if 
necessary. 
 
In the Output Columns section, check the box next to each field you want included in your results list. In this 
example, we are indicating that we want the Name and SSN fields from the SSN table and the Compensation 
field from the Compensation table to be included in the output. We are also indicating that we want the system-
generated Similarity score to be included. The Similarity score provides a measure of how “confident” Excel is in 
its matching of inexact data. With these processes complete, all that is left to do is click Go. 
 
Upon doing so, the Fuzzy Lookup Add-in analyzes the data in the two tables and provides the results list . 
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A close inspection of the data in the figure above reveals that the tool worked well, though not flawlessly. In 
particular, it did not find matches for Mariya Sergienko and Thomas Axen. Returning to the Fuzzy Lookup task 
pane, let us modify the Similarity Threshold setting to see if reducing the confidence level slightly increases the 
number of matches. To do this, drag the Zoom Slider to the left so that a smaller value – in this case, 0.4 – is in 
place. Once this is done, a greater number of matches occur as shown in the figure below. 
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Inquire 
Inquire is a Microsoft add-in for Excel 2013 and beyondthat allows users to compare versions of a workbook, 
check workbooks for problems and inconsistencies, and identify links between workbooks or worksheets. In a 
nutshell, Inquire allows users to analyze, review, audit, and document their workbooks. By using Inquire, users 
will better understand the design and function of their workbooks, along with potential errors, data 
dependencies, and security concerns. 
 
If the INQUIRE tab does not appear in the ribbon, enable the add-in in Excel. Click File, Options, Add-ins,  
select COM Add-ins in the Manage box in the pane on the right, and then click Go. Check Inquire in the COM 
Add-ins dialog box and click OK to enable the add-in, which will now appear in the ribbon, as shown in the 
figure below. 

 
The primary means of analyses available in Inquire are 1) a tool to analyze workbooks and provide textual 
summary reports, 2) tools to identify and provide a graphical map of relationships among workbooks, 
worksheets, and cells, 3) a link to Spreadsheet Compare (a separate application that is included with Office 
2013 Professional Plus) for comparing workbook files, 4) a tool to remove excess formatting from empty cells in 
worksheets or workbooks, and 5) a password manager to ease the burden of analyzing password-protected 
files. The Inquire tools can be used in conjunction with or as a supplement to the formula auditing and 
evaluation tools available in all versions of Excel. 
 
Workbook Analysis produces a comprehensive analysis of the workbook, sheet by sheet and cell by cell. The 
Summary section identifies any linked workbooks or data connections used by the workbook, provides a history 
of the file (author, creation date, last modification date), and identifies the number of hidden and unhidden 
sheets. Other sections comprehensively document formulas, cells, ranges, and warnings. Check any areas for 
which additional scrutiny is desired, such as formulas with errors or the workbook summary, and then click the 
Excel Export button to export the details to a separate analysis workbook. Click Load Export File to open the 
analysis workbook, which contains the selected details and a column for reviewer comments, as shown in the 
Excel file Inquire – Workbook Analysis Report.xlsx. For complete and comprehensive documentation of a 
workbook, check Items in the Workbook Analysis Report before exporting it to Excel. 
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Workbook Relationship produces a graphical map of all other workbooks to which the current 
workbook links. Likewise, Worksheet Relationship provides a graphical map of all other worksheets 
to which the currently active worksheet links. Cell Relationship allows users to visualize how other 
cells and ranges link to the currently selected cell. 
 
Compare Files 
 
The Compare Files feature provides a feature that has long been sought by many users. With 
Compare Files, you can electronically compare two workbooks and instantly identify all differences 
between the compared workbooks. To use Compare Files, begin by opening the two workbooks 
you want to compare. (In our example the files are named are named F23A – Inquire and F23B – 
Inquire) Then, choose Compare Files from the Inquire tab of the Ribbon and select the two 
workbooks you want to compare, as shown below in Figure 23A. 

 
Upon clicking Compare in the lower right corner of the Select Files To Compare dialog box, Excel 
analyzes the two workbooks and generates a detailed analysis that highlights differences in data, 
formulas, formatting, and other characteristics. The figure below presents a sample of that 
analysis. 
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Clean Excess Cell Formatting provides users with a tool to clean unwanted formatting from blank 
cells, which is a common cause of bloated files and poor performance. 
 
Lastly, the Workbook Passwords feature is used to save workbook passwords. This relieves users 
of having to log in to password-encrypted linked files when running an analysis or file comparison 
in Inquire. 

 
How to Use the Quick Analysis Tool in Microsoft Excel 
In Microsoft Excel 2013 and beyond, the Quick Analysis tool makes it possible to analyze your data quickly 
and easily using different Excel tools. You can use Quick Analysis with a range or a table of data. To 
access Quick Access tool, select the cells that contain the data you want to analyze. The Quick Analysis tool 

button appears at the bottom right of your selected data. 

1. Select the cells of data that you want to analyze. 
 

 

2. Click the Quick Analysis button. The Quick Analysis toolbar appears with the 
options FORMATTING, CHARTS, TOTALS, TABLES, SPARKLINES. 
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3. Roll over each option in the Quick Analysis gallery to see a preview. 
 

4. To select an option, click it. 

 

The Quick Analysis tool is handy and quick to use as you can also have a preview of applying different options, 
before selecting the one you want. 

Conditional Formatting 
 

Conditional formatting makes data easier to interpret because a cell’s value controls the appearance of that 
cell. Conditional formats make analyzing data – spotting unusual observations, tracking trends, checking 
status, and finding top values – easier and more effective. These formats are called conditional formats 
because their application depends on whether the data meets the conditions you specify. 
Conditional formatting has been a part of Excel functionality since Excel 97, but it has been enhanced greatly 
over the years. Five types of conditional formats are available to apply to a cell or to a range of cells. 

• Highlight Cells Rules – Rules are created to highlight cells when some criteria are met. There are 
seven built-in rule types: Greater Than, Less Than, Between, Equal To, Text That Contains, A Date 
Occurring, and Duplicate Values. 
 

• Top/Bottom Rules – Formatting is applied to a selected range of cells that are more or less than a 
given threshold. There are six built-in rule types: Top N Items, Top N %, Bottom N Items, Bottom N 
%, Above Average, and Below Average. 
 

• Data Bars – This fills cells with gradient bars whose length is relative to all other values in the selected 
range. The color combinations available are dependent on the active theme. 
 

• Color Scales – This fills cells with gradient colors using a two- or three-color scheme. The shades are 
relative to all other values in the selected range. The color combinations available are dependent on 
the active theme. 
 

• Icon Sets – This fills the left-hand margin of cells with small graphic characters whose shape and color 
is relative to all other values in the selected range. 

 
To apply conditional formatting to a cell or range of cells, highlight the cells and then select Conditional 
Formatting from the Home tab of the Ribbon. Select the conditional formatting type desired and fill out any 
additional dialogs to complete the process. Monthly sales greater than $30,000 or those less than $7,000 are 
highlighted. Two Highlight Cells rules produce the formatting. 
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As shown in Error! Reference source not found., multiple rules can be applied to the same range of cells. 
However, when a cell meets the criteria of more than one rule, the rule highest in the Conditional 
Formatting Rules Manager will prevail. As new conditional formatting rules are created, they are added to 
the top of the Rules Manager list. The Rules Manager provides a single place to manage all rules for a 
selected range, the active worksheet, or another sheet in the active workbook. To access the Rules 
Manager, select Conditional Formatting, Manage Rules from the Home tab of the Ribbon. 
The second example uses the same data but applies Color Scales to the sales totals to help you understand the 
relative sales contribution of individual products as shown in the figure below. The detail columns have been 
hidden for presentation so that your focus is on total sales. In this case, the lowest sales volume is colored in 
red, the highest volume is colored in green, and the median value is colored in yellow. All other sales volumes 
are displayed in shades of these three colors to indicate their relative value. 
 

 
 

A similar result can be produced using Data Bars or Icon Sets as shown in the figure below. There are 
a large number of built-in icon sets. Rule thresholds for icon sets and color scales can be adjusted 
through the Rules Manager. Both data bars and icon sets can be displayed with or without values. 
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Figure 3 - Conditional Formatting Using Data Bars and Icon 

Sets 
 

 The Highlight Cells rules are the only rules that operate independently on each 
cell formatted with the condition. The other rule types format cells relative to 
the values of the other cells in the range formatted. For example, the length of 
data bars is relative to the largest value in the range formatted with the 
condition. If a range is expanded to include a larger value, the length of the 
data bars in the entire range will change. 

 
The last example of conditional formatting will use a formula to apply formatting to accounts whose variances 
are greater than 10% of budget. The condition will be applied to the complete report table so that the entire 
row for each account meeting the condition will be highlighted in color.  as shown in the figure below displays 
the finished report along with the conditions set in the New Formatting Rule dialog box. 
 

 
 

To create the formatting rule, follow these six steps. 
1. Highlight the range on which the conditional formatting will apply. In this case, highlight the range 

A5:E20. 
 

2. From the Ribbon, select Home, Conditional Formatting, New Rule. 
 

3. In the New Formatting Rule dialog box, select Use a formula to determine which cells to format. 
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4. Enter the following formula in the formula box. 

 
=ABS($E5/$C5)>=0.1 
 

5. Click the Format… button and choose the desired format to be applied to the selected cells when 
the criterion specified in the formula is met. Click OK. 

 
6. Click OK to format the report. 

 
All rows associated with absolute values of variances that are greater than 10% of budget are now 
highlighted in the report. 
 

 A bit of caution is advisable when using conditional formatting. Not all users of 
the report may not be knowledgeable about formulas that control the 
formatting. For example, a person simply looking at the results in Figure 4 has 
no way of knowing the rule that created the yellow lines is based on 10% 
variances. Therefore, it may be a good practice to include an explanation or 
legend of what the conditional formatting reveals. 

Using Slicers to Filter Tables and PivotTables 
 
Think of Slicers, added to PivotTables with the 2010 release of Excel and to tables with the 2013 release of 
Excel, as end-user filters. Slicers allow you to filter data in a PivotTable, PivotChart, or table by clicking on 
buttons that represent one or more dimensions in a data set. You can resize and format these filtering 
windows like charts or other shapes in Excel. You can insert a Slicer by selecting any PivotTable or PivotChart 
and then selecting Insert Slicer from the PivotTable Tools, Analyze contextual tab of the Ribbon. By selecting 
the PivotTable or PivotChart first, the two objects will be associated with each other automatically. 
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The items in each Slicer are colored when selected as shown in Figure 5 and function similarly to the drop- 
down menus used to filter rows, columns, and report filters within a PivotTable. To clear filters and display 
all values in a PivotTable or PivotChart, click the Clear Filter icon in the Slicer's header. Additionally, you can 
associate a single Slicer with multiple PivotTables by manipulating the Report Connections settings from 
the Slicer Tools Options tab on the Ribbon. 
 
If you use Excel 2013 or newer, you can use Slicers to filter tables. To add one or more Slicers to a table, 
begin by clicking in the table. Next, choose Insert Slicer from either the Insert tab of the Ribbon or from the 
Table Tools Design tab of the Ribbon. Finally, choose the field(s) you want to filter with your Slicer and click 
OK to complete the process. As with Slicers applied to PivotTables, just click on the item(s) in the Slicer 
filter you want to use as your filter, and your table applies the filter immediately. 

 

Text 
Excel is, of course, best known for its ability to crunch numbers. It's also quite versatile, however, with handling 
text. As you know, you can enter text for such things as row and column headings, customer names and 
addresses, part numbers, and just about anything else. In addition (as you may expect), you can use formulas to 
manipulate the text contained in cells. 
 
A Few Words about Text 
 
When you enter data into a cell, Excel immediately goes to work and determines whether you're 
entering a formula, a number (including a date or time), or anything else. That “anything else” is 
considered text. A single cell can hold up to 32,000 characters — roughly equivalent to the 
number of characters in this chapter. But Excel is not a word processor, and I can't think of a 
reason why anyone would need to even come close to that number. 
 
Text Functions 
 
Excel has an excellent assortment of worksheet functions that can handle text. You can access 
these functions just where you'd expect: from the Text control in the Function Library group of the 
Formulas tab. Many of the text functions are not limited to text: They can also operate with cells 
that contain numeric values. You'll find that Excel is very accommodating when it comes to 
treating numbers as text. 
 
The following examples are to be found in the Excel file named F32A - Working with Text.xlsx. 
 
Joining Two or More Cells 
 
Excel uses an ampersand (&) as its concatenation operator. Concatenation is simply a fancy 
term that describes what happens when you join the contents of two or more cells. For 
example, if cell 
 
A16 contains the text Vancouver and cell B16 contains the text Montreal, the following formula will  
return VancouverMontreal: 
 
=A16&B16 
 
Notice that the two strings are joined together without an intervening space. To add a space 
between the two entries (to get Vancouver Montreal), use a formula like this one: 
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=A19&” “&B19 
 
Or, even better, use a comma and a space to produce Vancouver, Montreal 
 
=A22&”, “&B22 
 
TRIM removes all leading and trailingspaces and replaces internal strings of multiple spaces with 
asingle space. 
This example uses the TRIM function. The formula returns 
FourthQuarterEarnings(with no excess spaces): 
 
=TRIM(A26) 
 
Changing the Case of TextExcel provides three handy functions to change the case of text: 
 

• UPPER converts the text to ALL UPPERCASE. 

• LOWER converts the text to all lowercase. 

• PROPER converts the text to Proper Case (the first letter in each word is capitalized, as 
in a proper name). 

 
These functions are quite straightforward. The formula that follows, for example, converts the 
text in cell A32 to proper case. 
 
=PROPER(A32) 
 
If cell A1 contained the text MR. JOHN Q. PUBLIC, the formula would return Mr. John Q. 
Public. 
 
These functions operate only on alphabetic characters; theys imply ignore all other characters and 
return them unchanged. 
 
Extracting Characters from a String 
 
Excel users often need to extract characters from a string. For example, you may have a list of 
employee names (first and last names) and need to extract the last name from each cell.  Excel 
provides several useful functions for extracting characters: 

• LEFT returns a specified number of characters from the beginningof a string. 

• RIGHT returns a specified number of characters from the end of a string. 

• MID returns a specified number of characters beginning at a specified position within 
a string. 

 
Cell A35 contains the text string: K2E Canada Inc. The following formula returns the last eleven 
characters from cell A35; if A35 contains fewer than eleven characters, the formula returns all 
text in the cell: 
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=RIGHT(A35,11) 
 
The result is Canada Inc. 
 
Cell A36 contains the text string: K2E Canada Inc. The following formula returns the first eleven 
characters from cell A35; if A35 contains fewer than eleven characters, the formula returns all 
text in the cell: 
 

=LEFT(A36,11) 
 
The result is K2E Canada 
 
Cell A37 contains the text string: K2E Canada Inc. This next formula uses the MID function to return 
eleven characters from cell A37, beginning at character position 5. In other words, it returns 
characters 5 through 11. 
 

=MID(A37,5,11) 
 
The result is Canada Inc. 
 

Date-Related Worksheet Functions 
Excel has quite a few functions that work with dates. These functions are accessible by choosing 
Formulas ⇒ Function Library ⇒ Date & Time. 
 
The table below summarizes the date-related functions available in Excel. 
 

Date Function Table 
 

V Function What It Does 
 DATE Returns the serial number of a particular date 
 DATEVALUE Converts a date in the form of text 

to a serial number 
 DAY Converts a serial number to a day of 

the month 
** DAYS Returns the number of days 

between two dates 
 
* 

DAYS360 Calculates the number of days 
between two dates based on  a 
360-day year 

 DAYS360 Calculates the number of days 
between two dates based on  a 
360-day year 

 
* EDATE Returns the serial number of the 

date that represents the indicated 
number of months before or after 
the start date 

 
* 

EOMONTH Returns the serial number of the last 
day of the month before or 
after a specified number of months 

 MONTH Converts a serial number to a 
month 

   
* NETWORKDAY

S 
Returns the number of whole work days between two dates 

   
 NOW Returns the serial number of the 

current date and time 
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 TODAY Returns the serial number of today's date 
   
 WEEKDAY Converts a serial number to a day of 

the week 
* WEEKNUM Returns the week number in the 

year 
 
* 

WORKDAY Returns the serial number of the 
date before or after a specified 
number of workdays 

 
* 

 
YEARFRAC 

Returns the year fraction 
representing the number of whole 
days between the start date and the end date 

 YEAR Converts a serial number to a year 

 n versions prior to Excel 2007, these functions are 
available only when the Analysis ToolPak add-in is 
installed. 
** This function is only available in Excel 2013 

 
 

Displaying the Current Date 
 
The Excel file Working with Dates.xlsx illustrates the following date functions. 
 
The following formula uses the TODAY function to display the current date in a cell: 
 

=TODAY() 
 
You can also display the date combined with text. The formula that follows, for example, 
displays text, such as Today is Friday, April2, 2015: 
 

=”Today is “&TEXT(TODAY(),”dddd, mmmm d, yyyy”) 
 
It's important to understand that the TODAY function is not a date stamp. The function is updated 
whenever the worksheet is calculated. For example, if you enter either of the preceding formulas 
into a worksheet, the formulas display the current date. And when you open the workbook 
tomorrow, they will display the current date (not the date when you entered the formula). 
 
Displaying any Date 
 
You can easily enter a date into a cell by simply typing it while using any of the date formats that 
Excel recognizes. You can also create a date by using the DATE function, which takes three 
arguments: the year, the month, and the day. The following formula, for example, returns a date 
comprising the year in cell B9, the month in cell C9, and the day in cell D9: 
 

=DATE(B10,C10,D10) 
 
Often, you'll use the DATE function with other functions as arguments. For example, the following 
formula uses the YEAR and TODAY functions to return the date for April 2 of the current year: 
 

=DATE(YEAR(TODAY()),2,4) 
 
The DATEVALUE function converts a text string that looks like a date into a date serial number. 
The following formula returns 40508, which is the date serial number for August 22, 2013: 



Copyright © 2018, K2 Enterprises, LLC. Reproduction or reuse for purposes other than a K2 Enterprises’ training event is prohibited.  

 
=DATEVALUE(“8/22/2013”) 

 
To view the result of this formula as a date, you need to apply a date number format to the cell. 
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